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Abstract

KGeography is a geography learning tool for KDE. Right now it has seven
usage modes:

e Browse the maps clicking in a map division to see its name, capital and flag
e The game tells you a map division name and you have to click on it

e The game tells you a capital and you have to guess the division it belongs to
e The game tells you a division and you have to guess its capital

e The game shows you a map division flag and you have to guess its name

e The game tells you a map division name and you have to guess its flag

e The game shows an empty map and you have to place divisions on it one by
one
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Chapter 1

Introduction

KGeography is a geography learning tool for KDE. It allows you to learn about
the political divisions of some countries (divisions, capitals of those divisions
and their associated flags if there are some).
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Chapter 2

Quick Start to KGeography

When you run KGeography for the first time, it first asks you to choose a map
to start with.

Choose map to use - KGeography

Asia
Austria
Brazil
Canada
China
Europe
France
Germany

ltaly @
[taly by provinces

Here we choose Canada
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Choose map to use - KGeography

Africa
Asia
Austria
Brazil

China
Europe
France
GFermany

Italy @
[taly by provinces

[ (]34 H zancel l

And KGeography main window appears with the map of Canada:

KGeography
File Wiew Settings Help

Current map
Canatla

Browse the map

Click division in the map

Guess the capital of a division

Guess division frorm its Nag

|
|
Guess division from s capital I
|
|
|

Guess the flag of a division

You can then choose what type of learning or testing you want to do by looking
at the menu on the left:
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Current map:
Canada

zlick divizion in the map

Fess division from its capital

Eess the capital of a division

Guess division fram its flag

EUuess the flag of a division

Explore Map: a left mouse button click on an area of the map will display

informations about that area:
=

Location of Provinces or Territories: you are first asked how many questions
you want
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= Number of questions - KGeograpt 2 —

Howy many questions do you want? 1 to 13

Then you are asked to click on a specific province:

izarrect answers: 000
Flease click on Munawut

When you finish all the questions, a result dialog is shown with your correct
and uncorrect answers:
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YOur answers were - KGeography

Click on ...
Cuestion Your answer Correct answer

Munawut I
Mewfoundland

Mew Brunswick I
Prince Edward Island || NN
Yukon Territary I e
Ontarig I
Marth West Territories [N

Mova Scotia I

Gluehec

Saskatchewan I

You answered correctly B out of 10 gquestions

Place Provinces or Territories in the Map: the cursor takes the shape of a province
and you have to place it in the map:
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™ KGeography — O %
Fle View Settings Help

) &) & ¥
= | o Q !
Open Map Zoom Original Size Automatic Zoom = Move

Current map:
Canada

I Explore Map l

Test Yourself:

l Location of Provinces or Territories I

|Elace Provinces or Territories in the Mapl

I Provinces or Territories by Capital I

I Capitals of Provinces or Territories I

I Provinces or Territories by Flag I

I Flags of Provinces or Territories I

Correct answers: 0/0

Please place in the map:
Alberta

Provinces or Territories by Capital: you are asked to find the name of a province
among a choice of 4 given its capital:

Yellowknife is the capital of...

() Maova Scotia

() Marth West Territaries
) Mewfoundland

O Yukon Territory

Accept

And the results are displayed when the test is finished:
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Your answers were - KGeography

... Is the capital of ...

Question Your answer Correct answer
Yellowknife  Mewfoundland Morth West Territories
Victaria British Calumbia British Calumbia
Stdohn's Mewfoundland Mewfoundland
Fegina Saskatchewan Saskatchewan

Charlottetown Prince Edward Island  Prince Edward [sland

Halifax Mova Scotia Mova Scotia
Toronta Ontario Ontario
Winnipeng hanitoha hanitoha
Fredericton  Mew Brunswick Mew Brunswick

Whiteharse  Morh West Territaries Yukon Territory
You answered correctly 8 out of 10 guestions

Capitals of Provinces or Territories: you have a capital and four province names
and you must choose the correct one. As before, at the end a result dialog is
shown.

Provinces or Territories by Flag: a flag is shown and you must find the province
it belongs to.
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This flag helongs to:

() Quebec
() Prince Edward Island
() Maorth West Territories
() Munavut

Accept

Flags of Provinces or Territories: a province name is given and you must find
the correct flag among four.
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The flag of Mew Brunswick is...

o R

S

I:::I 1= B=

GBF
P

@Eﬂ_zﬂ

Accept
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Chapter 3
Using KGeography

KGeography displays informations about some countries and tests you about
those informations.

] KGeography - 0 X
File  \iew Seftings Help

(SNENE

Current rrap:
Canada

Browse the map

Click division in the map

Guess the capital of a division

Guess division from its Nlag

|
J
Guess division from jts capital ]
]
J
|

Guesg the flag of a division

(il

3.1 More KGeography features

Another feature of KGeography is the possibility of zoom on a map.

11
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<4 KGeography

Eile View Settings Help

Ba +

Current map: =)
Canada

Browse the map

Click division in the map

Guess division from its capital

Guess division from its flag

Guess the capital of a division l

Guess the flag of a division

&

1] E10]

You can click the Zoom and then draw a rectangle to zoom in a part of the
map. While in zoom mode, you can press right mouse button to go back to the
original map size (the Original Size action has the same effect). Use the scroll
bars to move around the zoomed map or use the Move action that will allow

you to drag the map using left mouse button. The Automatic Zoom feature
will make the map as big as possible.

12
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Chapter 4

How to make maps

A map in KGeography is made by two files, one is the image of the map and
the other one is its description.

4.1 Helper tool

You can find here a tool (made by Yann Verley) which helped him with the map
of France. To find out its usage, simply execute it and read the help message.
It basically creates the .kgn file from a plain text file and creates a file with the
colors it has assigned to each division, so you can fill the map according to
them.

There is another tool colorchecker.py written by Albert Astals Cid. You need
PyQt4 to run this. Just run this with the .kgm filename as argument (you also
need the .png file of the map in the same folder). This will tell you if any pixel
on the map has a different color which is not defined in the .kgm (description)
file.

4.2 Description file

The description file is needed and its file extension is .kgm. It should begin
with <map> and end with </map>.

Inside of those tags there should be:

e <mapFile> and </mapFile>: the name of the file (without any path) con-
taining the map image, e.g. ‘europe.png’.

e <name> and </name>: the name of map, e.g. ‘Europe’.

13
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e <divisionsName> and </divisionsName>: the general name of divisions in
this map, that is, Provinces, States, Countries, etc.

e A <division> and </division> for each division in the map.
Each division has these tags:

e <name> and </name>: the name of the division, e.g. “Albania’.

e <capital> and </capital>: the name of the capital of the division, e.g.
‘Tirana’.

e <ignore>and </ignore>: canbe setto yes, allowClickMode, allowClickFlagMode
and no. If this tag is set to yes then the division will be ignored when ask-
ing for divisions in that map. It is then as if this division does not exist in
KGeography quiz modes. If this tag is set to allowClickMode then KGeogra-
phy will ask for the division in the Location of ... mode but not in other quiz
modes. If this tag is set to allowClickFlagMode then KGeography will ask
for the division in the Location of ... mode and in the flag related quizes but
not in other quiz modes. Setting this tag to no means the division will appear
in all modes (browse and quizzes). This tag is optional and when there is no
<ignore> tag that means as it is set to no. For example ‘Algeria’ has this tag
set to yes in the ‘Europe’ map which means that ‘Algeria” will not be part of
any quiz in the ‘Europe’ map.

e <flag> and </flag>: the file (without any path) containing the flag of the
division, e.g. ‘albania.png’. This tag is optional. Not needed for the divisions
whose <ignore> tag is set to yes.

e <color> and </color>: the color the division has in the map.

e <falseCapital>and </falseCapital>: There can be any number of false-
Capital pairs, they are used to provide a list of false answers to the capital
question instead of choosing the false answers amongst the other divisions
capitals.

The color is defined using three tags:
e <red> and </red>: red component of the color. Valid values are between 0

and 255.

e <green> and </green>: green component of the color. Valid values are
between 0 and 255.

e <blue> and </blue>: blue component of the color. Valid values are be-
tween 0 and 255.

Tip

It is convenient to create 2 or 3 false divisions like ‘Water’, ‘Frontier’ and ‘Coast’ and
set them with the <ignore> tag setto yes. Don’t forget not to set color for any
‘Frontier’ 0,0,0 in RGB. Please make it something like 1,1,1 so that a border outline
comes while placing any division on the map.

14
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IMPORTANT
All names (capitals and divisions) must be in English.

4.3 Map file

The map file is quite simple but laborious to create. It has to be in PNG format.
You can find some maps to transform at Cia Reference Maps. If no map fits
your needs you can download the political world map, take a screenshot of
it and work from it. Each division in the map should have one and only one
color. To achieve this you can use image processing programs like The Gimp
and Kolourpaint.

4.4 Flags

If you have used the <flag> tag you should provide the flag files. They have
to be in PNG format and better if they are 300x200 pixels and you provide a
SVG file for it. To obtain SVG flags of almost all countries in the world and
some other divisions, you can consult the Sodipodi flags collection.

4.5 How to test

Before sending your map to Albert tsdgeos@terra.es, you should test it to see

it has no errors. To achieve that, you have to do the following:

e Put the map description and map image file in $KDEDIR/share/apps/kgeography/
e Put the flag PNG files (if any) in $KDEDIR/share/apps/kgeography/flags/

Once that has been done you should be able of opening your map from inside
KGeography.

If you don’t know which is your $XKDEDIR, type kde—config --prefix in a
shell.

TiP
Use the colorchecker.py tool from the helper tools to check if any extra color left on
the map which is not defined on the .kgm file.

15
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4.6 Non political maps

Is it possible to do non-political maps? Yes, it is!

Of course, the division concept can be extended to a river or a mountain. Dur-
ing the creation of the map, you should keep in mind that most times the river
or mountain will be too small that you should provide an additional click-
ing area. In this example the river would have the maroon area and color
<20,76,34> as its identifier.

16
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Chapter 5

Command Reference

5.1 The main KGeography window
5.1.1 The File Menu

File — Open Map... (Ctrl+O) Open the choose map dialog
File — Quit (Ctrl+Q) Quits KGeography

5.1.2 The View Menu

View — Zoom Goes in zoom mode

View — Original Size Sets the map back to its original size

View — Automatic Zoom Sets the map to automatic zoom using as much space
as possible

View — Move Moves the current map

5.1.3 The Settings Menu

Settings — Show Toolbar Show/Hide the KGeography toolbar.
Settings — Configure Shortcuts... Configure key shortcuts for KGeography.
Settings — Configure Toolbars... Configure the KGeography toolbar.

17
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5.1.4 The Help Menu

Help — KGeography Handbook (F1) Invokes the KDE Help system starting
at the KGeography help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KGeography will
open a help window (if one exists for the particular item) explaining the
item’s function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — About KGeography This will display version and author informa-
tion.

Help — About KDE This displays the KDE version and other basic informa-
tion.

18
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Chapter 6
Credits and License

KGeography
Program copyright 2004-2008 Albert Astals Cid tsdgeos@terra.es

Documentation Copyright (c) 2005 Anne-Marie Mahfouf annma@kde.org 2008
Kushal Das kushaldas@gmail.com

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.

19
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Appendix A

Installation

A.1 How to obtain KGeography
KGeography is part of the KDE project http:/ /www.kde.org/ .

KGeography can be found in the kdeedu package on ftp:/ /ftp.kde.org/pub/-
kde/ , the main FTP site of the KDE project.

A.2 Compilation and Installation

In order to compile and install KGeography on your system, type the following
in the base directory of the KGeography distribution:

$ ./configure
% make
% make install

Since KGeography uses autoconf and automake you should have no trouble
compiling it. Should you run into problems please report them to the KDE
mailing lists.

20
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